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Requesting	read	receipts	in	Gmail	helps	you	know	when	the	recipient	has	read	your	email.	Shannon	Fagan/Getty	Images	This	story	is	available	exclusively	to	Business	Insider	subscribers.	Become	an	Insider	and	start	reading	now.	You	can	send	read	receipts	on	Gmail	if	you	have	a	work	or	school	Gmail	account.	If	your	administrator	requires	it,	you
may	have	to	manually	approve	read	receipts	sent	to	you.	There	are	also	third-party	options	if	you	can't	access	the	built-in	read	receipts	feature	in	Gmail.	Sometimes	you	have	to	know	for	sure	that	your	email	has	been	received.	That's	when	read	receipts	come	in	handy.	If	you	have	Gmail,	you	may	have	access	to	the	read	receipts	feature.		However,	be
aware	that	unless	you	have	a	work	or	school	account	that's	set	up	by	an	administrator,	you	won't	have	access	to	this	built-in	tool.	That	said,	there	are	third-party	options	that	you	may	use	instead.	Here's	how	to	request	and	return	read	receipts	in	Gmail.	How	to	request	a	read	receipt	on	Gmail	1.	Go	into	your	Gmail	account.	2.	Click	Compose,	located
toward	the	top-left	corner	of	the	window.	Compose	your	email	as	you	usually	would.	Devon	Delfino	3.	Write	your	email.	4.	Click	the	down-caret,	located	in	the	bottom-right	corner	of	the	draft,	and	choose	Request	read	receipt.	Click	the	down-caret	and,	if	read	receipts	are	available	on	your	account,	select	the	option	in	the	pop-up.	Devon	Delfino	5.	Hit
Send.	How	to	return	a	read	receipt	on	Gmail	Sometimes	a	read	receipt	will	automatically	go	out	to	the	sender	when	you	open	an	email.	But	if	your	administrator	requires	you	to	approve	read	receipts,	you'll	have	to	approve	them	manually.	Here's	how:		1.	Go	into	your	Gmail	account	and	open	the	email	with	the	read	receipt.	2.	You'll	see	the	option	to
return	the	read-receipt	request	—	click	Send	receipts	if	you	want	the	sender	to	know	you've	gotten	their	email,	or	select	Not	now	to	skip	that	option.	Note:	If	you	choose	Not	now	instead	of	sending	the	read	receipt,	you'll	see	the	option	to	send	the	read	receipt	again	the	next	time	you	open	the	email.	Why	aren't	my	read	receipts	being	returned?	There
are	a	few	reasons	why	you	might	not	be	getting	read	receipts	back.	For	example,	the	recipient	may	have	chosen	to	not	send	the	read	receipt	back,	since	that's	an	option	they'll	have	when	they	open	the	email.	Or,	if	you	sent	it	to	a	group	mailing	list	or	to	someone	whose	administrator	or	platform	restricts	read	receipts,	your	read	receipts	won't	work.	
Third-party	read	receipt	options	If	you	don't	have	a	Gmail	account	that	qualifies	for	read	receipts,	you	can	use	a	third-party	service	to	access	the	feature.	A	few	examples	of	these	include:	Mailtrack:	This	browser	extension	tells	you	if	your	email	has	been	opened,	how	many	times,	and	if	you've	received	an	email	with	a	read	receipt	attached.	The	free
plan	gives	you	unlimited	tracking,	and	you	can	opt	for	a	paid	plan	to	access	more	features	like	real-time	notifications	and	group	email	tracking.	Boomerang:	In	addition	to	seeing	if	your	email	has	been	read,	you	can	also	see	the	number	of	times	it's	been	opened	and	which	links	have	been	clicked	with	this	tool.	You	can	get	up	to	10	message	credits	per
month	with	the	free	plan.	The	paid	options	add	features	like	unlimited	message	credits,	inbox	pause,	and	premium	support	to	the	mix.	Glassmass:	This	email	marketing	tool	lets	you	do	things	like	schedule	messages,	see	reports	on	opens,	clicks,	and	replies	to	your	emails.	For	a	single	person,	the	cost	is	$12.95	per	month	for	the	standard	plan	or
$19.95	per	month	for	the	premium	plan.	There	are	also	team	plans	available,	with	varying	prices	depending	on	the	number	of	users.	Table	of	Contents	Share	this	postHave	you	ever	sent	a	message	and	spent	the	next	several	days	wondering	if	the	recipient	even	opened	it?	A	delivery	receipt	is	an	email	notification	that	answers	this	question	for	you	by
sending	you	a	separate	email	to	your	inbox	when	the	recipient	opens	and	reads	your	message.	If	you	know	how	to	add	a	read	receipt	in	Outlook,	you	can	confirm	that	a	message	has	been	received	and	viewed,	even	if	the	recipient	doesn’t	respond	right	away.	This	feature	can	be	especially	useful	for	important	communications,	time-sensitive
information,	or	in	business	contexts	where	accountability	matters.	Just	remember:	anytime	you	customize	Outlook,	you	should	do	so	judiciously.	In	the	case	of	these	delivery	notifications,	you	should	always	respect	the	recipient's	privacy	and	preferences,	as	excessive	use	can	be	seen	as	invasive	and	annoying.	Declutter	your	Outlook	InboxGet	rid	of
email	clutter	and	boost	your	productivity	with	Clean	Email.	Try	it	FREE	If	you	want	a	delivery	receipt	in	Outlook	for	every	message	you	send,	you	can	follow	the	steps	below	(keep	in	mind	that	this	feature	is	only	available	with	Outlook	for	Windows,	meaning	Mac	and	web	users	can’t	program	an	Outlook	email	delivery	notification	this	way):	Open	the
Outlook	desktop	app.	Choose	File	→	Options	from	the	main	menu.	Click	Mail	from	the	options	on	the	left	side.	Scroll	down	to	Tracking.	Look	under	Tracking	for	the	section	labeled	“For	all	messages	sent,	request.”	Click	the	checkbox	for	“Read	receipt	confirming	the	recipient	viewed	the	message.”	Press	OK.On	Windows:	Open	Outlook	desktop
application	and	press	Compose.	Choose	Options	in	the	top	menu.	In	the	Tracking	section,	check	the	box	for	Request	a	Read	Receipt.	Press	Send	after	you	finish	your	message.	You	will	receive	an	email	when	the	message	is	opened.On	the	Web:	Open	your	inbox	at	.	Click	New	Mail.	In	the	top	menu,	click	Options.	Check	the	box	next	to	Request	read
receipt.Press	Send	after	you	finish	your	message.	You	will	receive	a	notification	when	the	message	is	opened.On	Mac:	Open	the	Outlook	app	and	press	New	Mail.	Choose	Receipts	in	the	top	menu.	Click	the	Read	Receipt	option.Click	Send	after	you	finish	composing	your	message.	You	will	receive	an	email	when	the	message	is	opened.Adding	a	read
receipt	in	Outlook	is	one	of	many	Outlook	tips	and	tricks	that	can	enhance	your	email	experience,	especially	for	those	who	work	in	sales	or	similar	fields.	Unfortunately,	an	Outlook	delivery	receipt	may	not	always	yield	the	results	you	are	looking	for.	A	delivery	receipt	comes	with	several	limitations,	including:	Third-Party	Email	Clients:	An	Outlook
delivery	receipt	often	only	works	between	compatible	email	clients.	If	the	recipient	is	using	a	different	email	service	or	a	third-party	email	client,	the	delivery	notification	may	not	function	correctly	or	may	not	be	supported	at	all.	Inconsistent	Implementation:	How	a	delivery	receipt	is	implemented	can	vary	between	email	clients	and	systems.	This	lack
of	standardization	can	lead	to	inconsistencies	in	how	delivery	verifications	are	handled,	meaning	your	read	confirmation	may	not	indicate	that	your	message	was	seen.	Recipient	Control:	The	most	significant	limitation	is	that	read	receipts	are	typically	under	the	recipient's	control.	The	person	you	sent	a	letter	to	can	choose	whether	or	not	to	send	a
read	receipt	on	Outlook.	Dependent	on	Email	Client	Settings:	The	effectiveness	of	read	receipts	depends	on	the	recipient's	email	client	settings.	If	the	recipient	has	configured	their	client	to	automatically	block	or	ignore	these	requests,	they	may	never	see	or	respond	to	them.Given	these	limitations,	even	if	you	know	how	to	add	a	read	receipt	in
Outlook,	you	should	not	rely	on	them	as	the	sole	means	of	tracking	email	interactions.Now	that	you	know	how	to	add	read	receipt	in	Outlook,	it's	important	to	know	how	to	use	it	effectively.	Below	are	some	best	practices	and	commonly	asked	questions	for	using	this	feature	without	causing	issues	for	others.When	to	use	and	when	to	avoidNot	every
situation	calls	for	adding	an	opened	email	indicator.	Therefore,	our	advice	is	to	do	the	following	when	you	use	a	read	receipt	on	Outlook.	Use	Them	Sparingly:	Reserve	delivery	receipts	for	situations	where	it's	genuinely	necessary	to	know	when	your	message	has	been	opened.	These	situations	may	include	critical	business	communications,	important
deadlines,	or	when	a	confirmation	of	receipt	is	crucial.	Avoid	Non-Urgent	Messages:	Requesting	reading	confirmation	for	every	email	can	come	across	as	intrusive	and	can	annoy	recipients.	Don't	use	them	for	routine	or	non-urgent	emails,	as	this	can	create	unnecessary	tension.	Consider	Recipient	Preferences:	Pay	attention	to	the	preferences	of	your
recipients.	If	you	know	someone	who	consistently	declines	read	confirmation	requests	or	values	their	privacy,	respect	their	choice	and	refrain	from	using	notifications	like	this	with	them.Is	it	rude	to	decline	a	read	receipt	on	Outlook?Declining	a	read	confirmation	is	not	inherently	rude.	People	have	valid	reasons	for	not	sending	receipts,	such	as
privacy	concerns,	the	desire	to	maintain	control	over	when	they	respond	to	emails,	or	the	fact	that	notifications	like	this	can	be	intrusive	in	some	cases.	However,	it's	important	to	handle	an	Outlook	email	read	receipt	with	courtesy.	If	you	choose	to	decline	a	request,	consider	sending	a	brief	follow-up	email	explaining	your	reasons.	Also,	try	to	strike	a
balance	between	respecting	privacy	and	meeting	expectations.	If	these	notifications	are	commonly	used	in	your	workplace,	it's	reasonable	to	comply	unless	you	have	specific	concerns.Notifications	that	inform	you	when	a	message	is	opened	help	you	confirm	that	your	emails	are	being	seen.	However,	these	notifications	also	add	to	the	number	of	emails
that	are	already	bouncing	into	your	inbox	each	day.	Therefore,	you	need	to	implement	a	great	Outlook	email	management	strategy	to	ensure	message	receipts	don’t	take	over	your	inbox.	Luckily	for	you,	Clean	Email	is	the	perfect	mailbox	management	app	for	the	job.	Clean	Email	is	not	an	email	client,	you	can’t	use	it	for	adding	read	receipts	in
Outlook	or	sending	messages.	However,	the	app	offers	many	great	features	to	help	you	organize	email	in	Outlook	so	you	can	maintain	a	clean	inbox.	For	example,	you	can	use	the	Auto	Clean	tool	to	automate	specific	actions	for	various	senders.	With	this	feature,	you	could	program	an	automation	to	separate	all	of	your	Outlook	email	read	receipt
messages	into	their	own	folder	so	you	can	verify	which	messages	were	opened	and	which	were	not.	You	could	also	program	similar	automations	to	star	or	flag	the	replies	you	get	to	messages	so	you	prioritize	following	up.	Other	features,	like	Unsubscriber	and	Cleaning	Suggestions,	make	it	easier	to	minimize	clutter	in	your	inbox.	The	Unsubscriber
tool	does	this	by	making	it	easy	for	you	to	unsubscribe	from	newsletters	and	marketing	emails	—	it	takes	just	a	few	clicks	to	remove	yourself	from	all	messages	from	certain	senders	or	domains.	Meanwhile,	Cleaning	Suggestions	offers	quick	actions	you	can	take	to	items	sitting	in	your	main	inbox	based	on	previous	actions	you’ve	taken	and	data	on
what	other	users	have	done	with	similar	emails.	It’s	a	great	way	to	delete	old	emails	in	Outlook	or	archive	messages	you	don’t	need	cluttering	your	primary	inbox.	With	fewer	messages	in	your	inbox,	it’s	easier	to	find	these	delivery	notifications	and	other	replies.	Clean	Email	makes	it	easy	to	declutter	and	organize	your	inbox	from	anywhere	—	it’s
available	on	MacOS,	iOS,	Android,	and	as	a	web	app.	What's	important	is	that	Clean	Email	prioritizes	privacy	and	security.	The	app	will	never	collect,	store,	or	sell	your	personal	data,	so	you	can	use	it	without	fear	of	compromising	your	personal	information	or	receiving	targeted	advertisements.Delivery	notifications	can	help	you	ensure	time-sensitive
messages	are	seen	and	provide	insights	to	improve	your	electronic	communication.	However,	knowing	how	to	add	a	read	receipt	in	Outlook	is	just	one	of	many	tricks	you	can	use	for	better	inbox	management.	No	matter	what	you	need,	Clean	Email	is	always	here	to	help	you	organize	your	emails	and	improve	digital	communication.A	read	receipt	is	an
automated	notification	that	informs	the	sender	when	the	recipient	has	opened	and	presumably	read	the	email.	In	both	the	Outlook	desktop	and	web	apps,	you	can	request	an	email	read	confirmation	by	going	to	the	"Options"	menu	while	composing	a	new	email	and	selecting	the	"Request	a	Read	Receipt"	check	box	before	sending	the	email.	No,	in
Outlook,	the	recipient	will	always	receive	a	prompt	asking	them	to	send	a	read	confirmation,	so	you	cannot	request	a	read	confirmation	without	the	recipient	knowing.	Try	Clean	Email	for	Free4.4based	on	1011	user	reviewsGet	StartedUse	tools	like	Cleaning	Suggestions	and	Smart	Folders	to	help	you	quickly	clean	out	an	overloaded	inboxKeep
unwanted	emails	out	of	your	inbox	by	unsubscribing—even	from	email	lists	that	don’t	have	an	unsubscribe	linkAutomate	repetitive	tasks	with	Auto	Clean	rules	to	archive	emails	as	they	become	old	or	to	sort	them	into	folders	Important:	Read	receipts	are	only	available	to	work	or	school	accounts.	They	don't	work	with	personal	Gmail	(@gmail.com)
accounts.	To	request	or	return	a	read	receipt,	sign	in	to	an	eligible	account.	To	find	out	when	an	email	you	sent	was	opened,	you	can	request	a	read	receipt.	A	read	receipt	is	sent	to	you	as	an	email	with	the	time	and	date	of	when	your	message	was	opened.	Request	a	read	receipt	Important:	To	receive	a	read	receipt	in	your	inbox,	the	recipient	of	your
email	may	need	to	approve	it	first.	On	your	computer,	open	Gmail.	Click	Compose.	Compose	your	email	as	you	normally	would.	At	the	bottom	right,	click	More	options	Request	read	receipt.	Click	Send.	Return	a	read	receipt	If	you	receive	a	message	that	requests	a	read	receipt,	and	your	organization	wants	you	to	approve	it	first:	On	your	computer,
open	Gmail.	Check	your	emails	as	you	normally	would.	If	a	message	tells	you	a	sender	has	requested	a	read	receipt,	choose	an	option:	To	send	the	receipt	now,	click	Send	receipts.	To	send	the	receipt	later,	click	Not	now.	You'll	be	asked	to	send	the	receipt	the	next	time	you	open	the	message.	Tip:	If	someone	requests	a	read	receipt,	but	you	don't	see
a	message,	your	receipt	was	sent	automatically.	When	receipts	aren't	returned	Read	receipts	work	across	most	email	systems,	but	you	won't	get	a	read	receipt	if:	You	send	a	message	to	a	group	mailing	list	or	alias.	Your	administrator	restricts	receipts	to	people	within	your	organization	or	to	specific	people	outside	your	organization.	The	recipient	uses
an	email	program	that	doesn't	sync	in	real	time	(like	a	Post	Office	Protocol	[POP]	client	that	syncs	only	on	demand,	or	a	Google	Workspace	Sync	client).	The	recipient	returns	a	read	receipt	on	an	email	client	using	Internet	Message	Access	Protocol	(IMAP)	and	read	receipts	aren't	sent	automatically.	Don't	rely	on	receipts	to	certify	delivery	Getting	a
read	receipt	doesn't	always	mean	the	recipient	read	your	message.	How	a	receipt	works	depends	on	which	email	system	your	recipient	uses.	For	example,	you	may	get	a	read	receipt	if	a	person	using	an	IMAP-based	email	client	marks	your	message	as	read,	but	doesn't	open	it.	Some	non-IMAP	mobile	email	systems	may	not	return	receipts	at	all.	Post
to	the	help	community	Get	answers	from	community	members	If	you	want	to	ensure	that	someone	has	received	your	message,	you	can	request	a	delivery	receipt	and	a	read	receipt.	Thus,	when	the	recipient	downloads	your	message	from	his	or	her	ISP's	e-mail	server,	you	receive	an	automatic	e-mail	delivery	message.	You	can	also	receive	a	read
receipt,	which	notifies	that	your	message	was	opened	by	the	recipient.	Both	of	these	receipts	are	great	for	ensuring	that	recipients	have	actually	received	and	read	your	message.	However,	please	be	aware	that	the	recipient	can	reconfigure	their	email	client	to	prevent	sending	such	notifications	automatically.	Additionally,	the	recipient	will	be	notified
that	they	are	being	asked	to	provide	a	read	receipt	and	can	optionally	choose	to	confirm	or	ignore	the	request	altogether.	See	also	how	to	request	receipts	for	all	outgoing	messages.	Ask	for	a	delivery	and	read	receipts	for	a	message	in	Outlook	for	Windows	On	a	new,	reply,	or	forward	message,	to	request	a	receipt,	do	one	of	the	following:	If	you	use
the	Simplified	ribbon	(see	more	about	customizing	ribbons),	on	the	Options	tab,	click	the	appropriate	button:	Request	a	Delivery	Receipt	to	track	when	the	email	is	delivered	to	the	recipient,	Request	a	Read	Receipt	to	track	when	the	recipient	opens	and	reads	the	email	message.	If	you	don't	see	these	checkboxes	on	the	ribbon,	click	the	More
commands	button	-	three	points	to	the	very	right	of	the	ribbon	buttons.	After	clicking	any	of	these	buttons,	a	checkmark	appears	before	the	button	name:	Note:	You	also	can	set	all	the	message	options	in	the	Proprieties	dialog	box	(see	more	about	message	options).	To	open	it,	click	the	Tracking	dialog	box	launcher:	Or	select	Message	Options...	on	the
Options	tab	(see	above).	If	you	use	the	Classic	ribbon,	on	the	Options	tab,	in	the	Tracking	group,	select	the	appropriate	checkbox:	To	open	the	Properties	dialog	box,	on	the	Options	tab,	in	the	Tracking	group,	click	the	dialog	box	launcher:	In	the	Properties	dialog	box:	To	request	a	delivery	receipt,	select	the	Request	a	delivery	receipt	for	this	message
checkbox.	To	request	a	read	receipt,	select	the	Request	a	read	receipt	for	this	message	checkbox:	Click	the	Close	button	and	send	the	message	as	usual.	When	the	message	is	delivered	and	read,	you'll	receive	a	confirmation	e-mail	message:	Delivery	receipt	examples:	Read	receipt	example:	Note:	If	you've	requested	a	receipt	but	don't	receive	one,	it
doesn't	necessarily	mean	your	message	wasn't	delivered	or	read.	Some	e-mail	programs	do	not	send	delivery	or	read	receipts.	Ask	for	a	delivery	and	read	receipts	in	Outlook	for	Web	On	a	new,	reply,	or	forward	message	in	Outlook	for	Web,	to	request	a	receipt,	do	one	of	the	following:	If	you	use	the	Simplified	ribbon	(see	more	about	customizing
ribbons),	on	the	Options	tab,	select:	The	Request	delivery	receipt	checkbox	to	track	when	the	email	is	delivered	to	the	recipient,	The	Request	read	receipt	checkbox	to	track	when	the	recipient	opens	and	reads	it.	If	you	don't	see	these	checkboxes	on	the	ribbon,	click	the	More	commands	button	-	three	points	to	the	very	right	of	the	ribbon	buttons:	If
you	use	the	Classic	ribbon,	on	the	Options	tab,	in	the	Tracking	group,	select	the	Request	delivery	receipt	and	Request	read	receipt	checkbox:	Receive	a	message	with	the	requested	read	receipt	in	Outlook	When	you	open	a	message	that	requests	a	read	receipt,	by	default,	for	the	first	time,	Outlook	displays	information	about	the	confirmation	that	was
requested:	Outlook	for	Windows	opens	the	warning	message	"{sender}	requested	a	read	receipt	be	sent	when	message	{subject}	is	read.	Do	you	want	to	send	a	receipt?":	You	can	confirm	sending	a	message	read	receipt	by	clicking	Yes	or	refuse	sending	it	by	clicking	No.	Outlook	for	Web	displays	the	information	"The	message	sender	has	requested	a
read	recipient.	To	send	a	receipt,	click	here."	above	the	message:	You	may	ignore	this	message	and	not	send	the	requested	notice.	To	confirm	sending	the	read	receipt,	click	the	click	here	link.	Outlook	displays	information	"A	read	receipt	has	been	sent	to	this	sender."	above	the	message:	See	also	this	tip	in	French:	Comment	demander	un	reçu.	Today,
30%	of	our	visitors	use	Ad-Block	to	block	ads.We	understand	your	pain	with	ads,	but	without	ads,	we	won't	be	able	to	provide	you	with	free	content	soon.	If	you	need	our	content	for	work	or	study,	please	support	our	efforts	and	disable	AdBlock	for	our	site.	As	you	will	see,	we	have	a	lot	of	helpful	information	to	share.	“If	you’re	sending	an	important
message	and	want	to	be	sure	that	the	recipient	will	get	it	and	open	it.	Or	in	other	words	if	you	want	to	get	delivery	and	read	receipts	confirmation	then,	you	can	easily	add	delivery	and	read	requests	to	this	single	message:”	By	using	the	Outlook	delivery	and	read	receipts	confirmation	rule	you	will	notify	individual	messages	also	when	the	receiver	gets
the	messages	and	opens	them.	When	you	send	an	important	message	to	someone	then	you	can	request	one	of	them	or	both	at	once.	Or	you	can	add	read	receipts	to	all	your	emails.	It’s	even	possible	to	create	a	special	read	receipt	rule.	Would	you	like	to	know	how	to	do	it?	Go	ahead	and	read	this	article!	Let’s	Define	the	Difference	Between	Delivery	&
Read	Receipts	A	delivery	receipt	informs	you	that	your	email	message	was	or	wasn’t	delivered	to	the	recipient’s	mailbox.	There	is	no	guarantee	that	the	email	is	in	the	recipient’s	inbox.	It	can	be	accidentally	removed	to	the	junk	e-mail	folder.	On	the	other	hand,	the	read	receipt	notifies	when	the	user	will	open	the	message.	The	person	who	sends
opens	the	message	sends	the	read	receipts.	If	you	get	a	confirmation	that	your	email	is	read	by	the	address,	it	is	obvious	that	the	user	gets	the	email	as	well.	Set	Delivery	&	Read	Receipt	Confirmation	for	Single	Mails	Step	1	Firstly,	create	a	new	“Email“.	Step	2	Secondly,	click	on	the	“Options	Tab”	in	the	New	Email	window.	Step	3	Tick	the	“Request	a
Delivery	Receipt”	and	after	that,	the	“Request	a	Read	Receipt”	boxes	in	the	Tracking	group.	Step	4	Next,	press	the	“Send”	button.	Step	5	If	the	recipient	opens	the	message,	then,	you	will	get	an	email	notification	like	the	one	below:	Furthermore,	if	you	want	to	track	all	Sent	messages	of	Outlook	by	default,	then	enable	the	Delivery	and	Read	Receipt
confirmation	option.	For	Outlook	2002,	2003,	and	2007:	Step	1	Go	to	the	“Tool”	menu	and	then,	click	on	“Options“.	Step	2	Here,	on	the	“Preference”	tab,	click	on	“E-mail	Options”	under	E-mail	and	then	click	on	“Tracking	option“.	Step	3	Now,	checkmark	on	“Read	Receipt”	and	“Delivery	Receipt”	under	“For	all	messages	I	send,	request“.	Read
Receipts	Confirmation	For	Outlook	2010	and	2013:	Step	1	Step	2	Afterward,	select	the	“Mail”	option.	At	last,	under	the	tracking	option,	checkmark	the	box	“Delivery	receipt	confirming	the	message	was	delivered	to	recipient	email	server“.	By	applying	these	settings,	you	will	be	able	to	get	confirmation	as	you	want.	But,	keep	in	mind	that	the	recipient
has	the	power	to	decline	to	send	a	read	receipt	as	I	have	already	mentioned	above.	The	Bottom	Line	The	above	blog	explains	how	to	set	delivery	&	read	receipts	for	single	as	well	as	multiple	emails	in	various	Microsoft	Outlook	versions	in	a	few	clicks.	As	a	result,	by	applying	these	steps,	you	will	get	the	assurance	of	your	emails.	In	this	guide,	you’ll
learn	what	read	receipts	are	and	how	to	add	receipts	in	Gmail	and	Outlook.	Plus,	third-party	alternatives	in	case	Gmail	and	Outlook	read	receipts	aren’t	cutting	it	for	you.Here’s	what	we’ll	cover:		Table	of	Contents:	Let’s	dive	right	in:		What	is	a	read	receipt?	A	read	receipt	notifies	you	if	(and	when)	a	recipient	opens	your	email.	The	receipt	confirms
that	the	recipient	saw	your	message	and	records	the	approximate	time.Here’s	what	a	read	receipt	looks	like	in	Superhuman:	We	call	them	read	statuses.	They	tell	me	who	opened	my	email	and	the	date,	time,	and	device	used.No	need	to	wonder	if	someone	opened	or	ignored	your	email.	Read	receipt	tracking	ensures	you’re	no	longer	in	the
dark.	Whether	you’re	trying	to	build	rapport	with	clients,	boost	sales	results,	or	work	effectively	with	your	team.	With	read	receipts,	you	can	follow	up	at	the	right	time.	Every	time.Sidenote:	Some	tools	can	also	track	a	recipients	approximate	location	based	on	their	IP	address.	This	violates	the	privacy	of	the	recipient.	How	do	read	receipts	work?
Email	tools	add	tracking	pixels	to	outgoing	emails.	Once	opened,	the	recipient's	email	program	downloads	the	pixel	(like	a	browser	would).	Next,	the	image	server	logs	this	request	and	uses	its	IP	address	to	guesstimate	your	recipient's	location.	Long	story	short:	By	adding	a	tiny	invisible	1x1	image	to	your	email,	you	can	gather	information	on	who
opened	your	email,	when,	where,	and	how	often.Pixel	tracking	isn’t	new.Mailchimp,	Google	Analytics,	and	Facebook	(among	others)	have	been	using	pixel	tracking	for	years	to	collect	data	about	open	rates,	website	visits,	and	all	possible	online	behavior.For	example,	the	meta	pixel	can	track:Add	to	cart	(or	wishlist).Initiate	checkout.Add	payment
info.	Purchase.Page	views.	And	more.	Tools	like	Mailchimp	can	track	open	rates,	clicks,	forwards,	scroll	depth,	etc.	Marketers	can	use	this	data	to	create	effective	email	marketing	campaigns.	How	to	add	a	read	receipt	in	Gmail?	Gmail	read	receipts	are	only	available	for	users	of	Google	Workspace	(G	Suite).	Also,	it	only	works	on	the	web	client.	There
is	no	read	receipt	option	on	the	iPhone	or	Android	Gmail	app.If	you	want	to	use	read	receipts	on	your	personal	Gmail	account,	we’ll	cover	some	options	later.Here’s	how	the	Gmail	read	receipts	function	works:By	default,	Gmai	has	disabled	read	receipts.	If	you’re	a	Google	Workspace	admin,	you’ll	have	to	enable	read	receipts	for	your	entire	team
manually.	How	to	enable	Gmail’s	read	receipts:Login	to	your	Google	admin	console:	Click	on	Google	Apps	>	Google	Workspace	>	Gmail:Click	on	User	Settings.	Scroll	down	to	find	Email	read	receipts:	You	have	a	few	options.	You	can	allow	read	receipts	in	your	organization	(with	some	allowlisted	external	addresses)	or	enable	read	receipts	for	all
email	address.	If	you	prompt	the	user	for	each	read	receipt,	Gmail	will	notify	them	(by	email)	to	consent	to	send	a	read	receipt.	Enabling	this	feature	will	end	up	cluttering	your	team’s	inboxes;	we	recommend	turning	it	off.Hit	SAVE.	You’ve	enabled	read	receipts	on	Gmail!Sidenote:	Activating	read	receipts	takes	a	few	hours.	Once	on,	Gmail	will	send
receipts	to	your	recipients.	If	they	click	on	Send	Receipts	in	the	pop-up,	Gmail	will	notify	you	with	a	read	receipt	confirmation:Courtesy:GmassHow	to	send	a	read	receipt	in	Gmail:	Open	your	Gmail	inbox.	Compose	an	email:Below	the	compose	window,	click	on	More	options	(3-dots).	Click	on	Request	read	receipt:	Hit	the	Send	button.	Gmail	will	now
send	a	read	receipt	request	to	your	recipient.	If	they	accept,	Gmail	will	notify	you	that	they	read	your	email.Gmail	read	receipts	won’t	work	in	these	scenarios:You	send	a	message	to	a	Gmail	group	or	email	alias.Your	admin	restricts	receipts	to	specific	people.The	recipient	uses	a	POP	email	client	that	doesn't	sync	in	real-time.	The	recipient	returns	a
read	receipt	on	an	IMAP-based	email	client.(We’ve	been	unable	to	make	read	receipts	work	on	Gmail	despite	double-checking	settings	and	sending	multiple	emails.)Sidenote:	Gmail	read	receipts	are	unreliable.	You’ll	often	get	a	read	receipt	even	when	your	recipient	didn’t	open	your	email.	Plus,	they	don’t	work	on	most	browsers	and	email	clients.	The
worst	part:	Google	only	offers	read	receipts	to	Google	Workspace	accounts.	You're	out	of	luck	if	you	use	the	free	version	of	Gmail.	Are	you	looking	to	switch?	Here	are	7	Gmail	alternatives.	How	to	add	a	read	receipt	in	Microsoft	Outlook?	Read	receipts	and	delivery	notifications	are	only	available	in	some	Outlook	versions.	You	can	only	use	Outlook
read	receipts	on	an	active	Microsoft	365	or	Exchange	Online	plan.For	example,	you	can't	request	receipts	in	Outlook.com	but	can	do	so	for	emails	sent	via	Outlook	for	Windows.	You	can	request	read	receipts	for	individual	emails	or	all	Outlook	emails.	Let’s	explore	both	options:1.	Outlook	read	receipts	for	a	single	message	Outlook	offers	both	delivery
and	read	receipts.	Delivery	receipts	confirm	the	delivery	of	an	email.	Read	receipts	track	if	they	opened	your	email.	In	both	cases,	Outlook	will	notify	you	by	email.Here’s	how	to	track	a	single	email	on	Outlook:	1.	In	a	new	email	message,	head	to	the	Options	tab.2.	Select	the	Read	Receipt	check	box	in	the	tracking	section.	To	track	delivery,	check	the
Request	a	Delivery	Receipt:	3.	Hit	send.	Outlook	will	notify	your	recipient	if	they	want	to	send	a	read	receipt.If	they	click	Yes,	Outlook	will	notify	you	that	they’ve	read	your	email:	To	track	read	receipts,	visit	your	sent	items	folder.	Open	the	sent	email.	In	the	Message	tab,	click	the	Tracking	button	(in	the	Show	group):You	can	now	see	if	recipients
opened	your	email.In	Outlook	for	Windows,	you	can	track	multiple	read	receipts	faster,	create	automated	rules,	or	disable	read	receipts	entirely.	This	guide	by	Ablebits	shows	you	how.2.	Outlook	read	receipts	for	all	emailsUnlike	Gmail,	you	can	set	up	Outlook	to	request	read	receipts	for	all	emails	automatically.	Here’s	how	to	track	all	your	Outlook
emails:	1.	Open	the	File	tab.	Select	Options	>	Mail.	2.	Under	Tracking,	select	Delivery	receipt	confirming	the	message	was	delivered	to	the	recipient's	e-mail	server	or	Read	receipt	confirming	the	recipient	viewed	the	message:	You	can	also	check	both	the	request	delivery	and	the	read	receipt	checkbox.Click	OK	to	apply	your	changes.How	to	enable
read	receipts	on	Outlook	Web:	Open	your	Outlook	account.	At	the	top	of	the	compose	pane,	click	the	3-dot	icon:	Select	Show	message	options.	Select	Request	a	read	receipt,	Request	a	delivery	receipt	or	both.	You’ve	now	enabled	read	receipts	in	Outlook	Web!	Open	Outlook	Settings	(gear	icon)	>	Message	handling.Scroll	down	to	find	Read
receipts.	Choose	how	to	respond	to	requests	for	read	receipts:	Pro	Tip:	Track	single	emails	of	importance	instead	of	all	emails.	Recipients	who	occasionally	get	a	read	receipt	request	are	likelier	to	send	a	read	receipt	than	if	you	notify	them	each	time	they	get	an	email	from	you.	Sidenote:	While	helpful,	Outlook	read	receipts	aren’t	foolproof.	The
recipient	can	simply	decline	to	send	the	read	receipt.	Some	email	clients	(like	Hey!)	block	read	receipts	entirely.	Read	receipts	on	Outlook	only	work	if:	You’re	using	Microsoft	365,	2019	Mac	(v15.35)	version	of	Outlook	or	later.You’re	on	an	active	Microsoft	365	or	Exchange	Online	plan.Read	receipts	aren’t	available	on	@outlook.com	email	accounts	or
POP/IMAP-based	email	services	like	Gmail,	Yahoo!,	or	iCloud	Mail.Optional	Reading:	8	best	Outlook	alternatives.	Read	receipt:	Third-party	tools	1.	Gmail	and	Outlook	add-onsMany	third-party	add-ons	offer	read	receipts	in	Gmail	and	Outlook.Some	popular	ones	are:	1.	MailtrackMailtrack	is	one	of	the	best	free	third-party	tools	for	read	receipt	tracking.
Plus,	their	email	tracking	feature	is	unlimited	and	free.	With	read	receipts,	Mailtrack	also	offers:	Real-time	notificationsDaily	email	reportsEmail	campaignsClick	trackingMail	mergingCaveat:	The	last	three	features	are	only	available	on	advanced	plans.While	technically	free,	Mailtrack	automatically	adds	its	signature	to	each	email.	Which	lets
recipients	know	you’re	tracking	their	emails:To	remove	the	Mailtrack	signature,	you’ll	have	to	purchase	their	pro	plan.Mailtrack	works	on	both	Gmail	and	Outlook.	If	you’re	looking	for	a	free	email	tracking	tool	(and	don’t	mind	their	branding),	Mailtrack	is	an	excellent	option.	2.	BoomerangBoomerang	offers	many	features:	1-click	calendar	scheduling,
schedule	send	emails,	follow-up	reminders,	etc.But	Boomerang’s	read	receipt	feature	is	excellent:Boomerang’s	free	plan	offers:Unlimited	read	receiptsSchedule	send	emailsMeeting	schedulingEmail	remindersClick	trackingBoomerang	is	outdated,	buggy,	and	can	be	hard	to	use.	But	it’s	free.You	can	use	Boomerang	on	both	Gmail	and	Outlook.	3.
MixmaxMixMax	started	as	Gmail	on	steroids.	Now,	it’s	a	full-blown	revops	platform.MixMax	offers	excellent	email	tracking	for	free.	Here’s	how	it	works:		With	the	MixMax	free	plan,	you	also	get:	Instant	schedulingEmail	templatesEmail	polls	&	surveysCaveat:	Like	Mailtrack,	MixMax	adds	their	signature	to	your	emails.	With	their	free	plan,	you	can
track	just	100	emails	per	month.Upgrade	to	a	paid	plan	to	remove	the	MixMax	branding	and	track	more	emails.	Currently	only	available	on	Gmail,	MixMax	for	Outlook	is	coming	soon.Caveat:	These	tools	are	third-party	Chrome	extensions.	You	can	only	use	them	on	Chrome.	If	you	use	a	lot	of	add-ons	–	your	system	will	slow	down	to	a	halt.	More
importantly,	51%	of	browser	extensions	pose	serious	privacy	risks.2.	SuperhumanSuperhuman	is	the	fastest	email	experience	ever	made.	⚡Here’s	how	it	works:		Try	Superhuman	From	search	to	compose,	everything	is	FAST.	And	with	pro	features	like:	Split	inboxUndo	sendRemind	meSend	laterWork	offlineYou’ll	never	have	trouble	hitting	inbox	zero
again.	Let’s	talk	about	our	read	statuses	feature.	Here’s	how	it	works:If	someone	doesn't	reply,	read	statuses	can	show	you	why.	Maybe	they	never	opened	your	email.	Perhaps	they	opened	it	on	their	phone,	so	they	hit	snooze	until	they	returned	to	their	desktop.The	kicker:	Whether	you	use	Superhuman	for	Android,	Windows,	or	iOS.	Read	statuses
work	the	same	way	across	all	devices!	It	gets	better.	Unlike	other	email	clients,	you	can	track	multiple	opens	from	different	recipients	(on	various	devices).	All	on	the	same	email:	Only	on	Superhuman.How	to	use	read	statuses	in	Superhuman?	By	default,	we’ve	turned	off	read	statuses	in	Superhuman.	To	enable	read	statuses,	hit	Cmd+K	(Ctrl+K	on
PC),	type	“read	statuses”	and	hit	return:Once	done,	you’ll	see	a	notification	below	your	inbox:	Read	receipt	on	Superhuman	is	now	enabled!	Sidenote:	Unlike	other	email	trackers,	we	don’t	spy	on	you	(or	your	recipients).	Here's	how:For	starters,	Superhuman	read	receipts	are	opt-out	by	default.	You’ll	need	to	enable	read	receipts	manually.More
importantly:	We	don’t	collect	(or	show)	any	location	information	We	deleted	all	historical	location	data	from	our	apps.We	built	an	option	to	turn	off	all	remote	image	loading.Don’t	want	to	be	tracked?	You	can	turn	off	all	known	tracking	pixels.	This	setting	blocks	99%	of	tracking	pixels.	Or,	you	can	block	all	remote	images.	You’ll	receive	emails	as	usual.
The	sender	just	won’t	know	you	opened	them.But	that’s	not	all.	With	Superhuman	for	Teams,	your	team	will	move	faster,	reply	quicker,	and	get	more	done.Here’s	a	quick	overview:	1.	Team	Read	StatusesIf	you	enabled	read	statuses,	you	can	see	when	people	read	your	email	and	on	which	device.With	Team	Read	Statuses,	read	statuses	are	now	shared
across	your	team:	Let’s	say	a	teammate	emails	a	lead	and	CCs	you.	Even	though	you	didn’t	send	the	email,	you	can	still	see	when	the	lead	reads	it	—	including	how	many	times	and	whether	it	was	on	their	laptop	or	phone.	With	more	context,	you	can	write	better	follow-up	emails.2.	Team	Reply	IndicatorsImagine	you	and	your	team	get	an	urgent	email,
so	you	reply	quickly.	But	just	after	you	hit	send,	your	team	responds	as	well.	In	the	best	case,	you	look	disorganized.	In	the	worst	case,	you	contradict	each	other.With	Team	Reply	Indicators,	you	can	see	exactly	when	your	team	is	replying:	3.	Recent	OpensIf	you’re	a	salesperson,	you'll	love	recent	opens.In	Superhuman	for	Sales,	see	a	real-time	feed	of
people	opening	your	emails.	Know	when	you	are	top	of	mind	and	follow	up	in	a	timely	manner:	All	these	pro	features	make	Superhuman	one	of	the	best	email	clients.	But	don’t	take	our	word	for	it.	Try	it	for	yourself.	�Well,	well,	well…	look	who	is	a	@Superhuman	inbox	zero	champion!	If	you’re	looking	for	the	best	e-mail	experience	on	the	planet,	use
and	your	life	will	change	forever.	pic.twitter.com/HFYMvD4BsT—	Tim	Ryan	(@ryantnt)	May	24,	2023	Wrapping	upRead	receipts	for	Gmail	and	Outlook	don’t	always	work.	Gmail,	Outlook	add-ons,	or	an	email	client	like	Superhuman	offer	a	far	better	experience.Read	receipt	have	their	pros	and	cons.	Whether	you	love	(or	hate)	read	receipts,
Superhuman	gives	you	a	choice.	Enable	read	receipts	or	block	them	all.If	you're	looking	for	a	blazing-fast	email	experience	that	helps	your	team	save	4+	hours	weekly	and	respond	2x	fast,	try	Superhuman	today!	Reduce	distractions	and	save	4+	hours	every	week	with	Superhuman!	Read	statuses,	Keyboard	shortcuts,	Undo	send,	AI	triage,	Beautiful
design	Get	Superhuman	for	Email	Imagine	this:	You’re	swamped	at	work,	dealing	with	a	seemingly	endless	influx	of	emails,	documents,	and	packages.	Amidst	the	chaos,	you	receive	an	important	document	or	a	customer	complaint	via	email.	The	sender	anxiously	awaits	your	acknowledgment,	but	in	the	whirlwind	of	tasks,	it	slips	through	the	cracks.
Sounds	stressful,	right?Whether	you’re	in	a	customer	service	role	or	a	busy	professional	environment,	confirming	receipt	is	more	than	just	a	courtesy—it’s	a	necessity.	It	assures	the	sender	that	their	message	or	item	has	been	received,	builds	trust	and	a	plus	in	professional	relationships.But	here’s	the	kicker—many	businesses	and	professionals
overlook	this	simple	email.	They	leave	emails	unacknowledged,	missing	this	golden	opportunity	to	engage	with	customers	and	colleagues.In	this	article,	we’ll	delve	into	confirming	receipts.	We’ll	explore	why	reciepts	are	essential,	how	to	do	it	in	various	situations,	and	share	real-life	examples.	Your	customers,	colleagues,	and	supervisors	will	thank
you.What	exactly	is	a	confirmation	of	receipt?	Think	of	it	as	the	digital	equivalent	of	a	friendly	nod	or	a	handshake	when	you	receive	something.	It’s	a	way	of	acknowledging	receipt,	saying,	“Hey,	I’ve	got	this!”	But	instead	of	a	physical	gesture,	it’s	usually	in	the	form	of	an	email	or	a	digital	note.Confirming	receipt	is	not	just	about	good	manners—it
plays	a	crucial	role	in	tracking	business	transactions.	You	will	often	see	it	in	invoices,	proposals,	or	customer	complaints.	The	confirming	receipt	email	creates	a	record	that	the	item	has	been	received.	It’s	like	leaving	digital	breadcrumbs	that	can	help	trace	the	path	of	a	transaction	or	communication.In	a	nutshell,	a	confirmation	of	receipt	is	a	way	to
keep	things	transparent	and	organized.	And	ensuring	the	sender	that	nothing	gets	lost	in	the	shuffle.You	might	be	wondering,	“Is	it	really	that	important	to	acknowledge	receipt?”	The	answer	is	a	resounding	yes!	Here’s	why.First,	a	confirming	receipt	lets	the	sender	know	that	communication	is	received	and	understood.	It’s	like	saying,	“Hey,	I	got
your	message,	and	we	are	on	it!”	This	small	gesture	can	make	a	big	difference	in	making	the	sender	feel	heard	and	valued.	And	who	doesn’t	appreciate	that?But	there’s	more.	Confirming	receipt	also	provides	a	record	of	communication.	In	the	world	of	business	franchise	operations,	this	can	be	incredibly	valuable.	It	helps	keep	track	of	orders,
complaints,	and	any	other	exchanges	between	you	and	your	franchisees	or	customers.	This	means	no	more	scrambling	to	find	that	one	crucial	email	in	a	sea	of	messages!Lastly,	a	confirm	receipt	builds	trust	and	professionalism.	It	shows	that	you	are	reliable	and	organized,	two	qualities	that	are	highly	prized	in	any	professional	setting.	Plus,	it	gives
the	impression	that	you	value	transparency	and	open	communication,	which	can	go	a	long	way	in	nurturing	strong	business	relationships.In	the	world	of	contemporary	business	operations,	knowing	how	to	write	an	acknowledgment	receipt	is	a	game-changer.	Here’s	a	step-by-step	guide	to	help	you	craft	the	perfect	confirmation	of	receipt	with	all	the
relevant	details.Step	1:	Start	with	a	professional	greetingKick	things	off	with	a	friendly	yet	professional	greeting.	This	could	be	as	simple	as	“Dear	[Name]”	or	“Hi	[Name],”	depending	on	your	relationship	with	the	sender.	Remember,	first	impressions	matter,	even	in	emails!Step	2:	Acknowledge	the	receipt	of	the	specific	item	or	communicationNext,
get	straight	to	the	point.	Confirm	that	you’ve	received	the	item	or	message.	You	could	say	something	like,	“I’m	writing	to	confirm	that	I’ve	received	your	email	dated	[insert	date]	about	[insert	topic].”	This	not	only	acknowledges	receipt	but	also	shows	the	sender	that	you’ve	paid	attention	to	the	details.Step	3:	Mention	any	next	steps	or	actions,	if
applicableIf	there	are	any	follow-up	actions	required	from	your	end,	mention	them	here.	This	could	be	anything	from	“We	will	review	your	proposal	and	get	back	to	you	by	[date]”	to	“Our	team	is	processing	your	order	and	will	update	you	soon.”,	or	even	as	simple	as	“Kindly	confirm	receipt	regarding..”	This	keeps	the	communication	clear	and	sets
expectations	right	from	the	get-go.Step	4:	Close	with	thanks	and	your	signatureWrap	up	your	email	acknowledging	receipt	with	a	note	of	thanks	and	a	professional	sign-off.	Something	like,	“Thank	you	for	your	patience.	We	appreciate	your	business,”	followed	by	“Best	regards”	or	“Sincerely,”	and	then	your	name.And	there	you	have	it—a	step-by-step
guide	to	writing	a	professional,	courteous	acknowledgment	receipt.	It’s	simple,	it’s	effective,	and	it’s	a	powerful	tool	for	maintaining	open	and	transparent	communication	in	any	business	correspondence.Here	are	a	few	examples	of	how	to	confirm	receipt	in	different	situations.	Buckle	up,	it’s	time	for	some	real-world	application!Example	1:	Confirming
receipt	of	an	online	orderThis	email	template	can	be	a	valuable	addition	to	your	restaurant’s	email	marketing	strategy,	especially	for	promoting	your	online	delivery	services	as	part	of	your	overall	restaurant	marketing	plan.“Dear	[Customer’s	Name],Just	dropping	a	line	to	let	you	know	that	we’ve	received	your	online	order	(#12345)	placed	on	[date].
Our	team	is	on	it	and	will	have	your	items	shipped	out	as	soon	as	possible.	We	appreciate	your	business!Best	regards,	[Your	Name]”Example	2:	Confirming	receipt	of	a	recipient’s	account	payment“Hi	[Name],We’re	writing	to	confirm	that	we’ve	received	your	credit	card	payment	of	$[amount]	towards	your	account	(#67890).	Thank	you	for	your
prompt	payment.	We	value	your	business	and	are	here	for	any	questions	you	might	have.Best,	[Your	Name]”Example	3:	Confirming	receipt	of	a	wire	transfer	transaction	number“Dear	[Name],This	email	is	to	confirm	the	receipt	of	your	wire	transfer	with	the	transaction	number	#34567.	The	funds	have	been	successfully	transferred	to	our	account.	We
appreciate	your	timely	response	in	making	the	necessary	payment	arrangements.Sincerely,	[Your	Name]”Example	4:	Confirming	receipt	of	a	job	application“Dear	[Applicant’s	Name],We’re	writing	to	confirm	that	we’ve	received	your	job	application	for	the	position	of	[Job	Title].	Our	team	is	currently	reviewing	your	application	and	will	get	back	to	you
within	the	next	[time	frame].	We	appreciate	your	interest	in	our	company!Best,	[Your	Name]”Example	5:	Confirming	receipt	of	a	proposal“Hi	[Name],Just	dropping	a	line	to	acknowledge	receipt	of	your	proposal	titled	‘[Proposal	Title]’	dated	[date].	We	appreciate	the	time	and	effort	you’ve	put	into	this.	Our	team	will	review	it	and	respond	by
[date].Best	regards,	[Your	Name]”Example	6:	Confirming	receipt	of	a	complaint“Dear	[Customer’s	Name],We’re	writing	to	confirm	receipt	of	your	complaint	regarding	[issue].	We	take	customer	feedback	seriously	and	we’re	already	working	on	resolving	the	issue.	You	can	expect	an	update	from	us	by	[date].	We	appreciate	your	patience.Sincerely,
[Your	Name]”These	are	just	examples.	Feel	free	to	tweak	them	to	fit	your	specific	situation	and	personal	style.	The	key	is	to	keep	your	confirmation	clear,	professional,	and	friendly.	If	you’re	looking	for	other	types	of	templates,	for	example,	sales	templates	or	lead	magnet	templates.	We	also	have	a	guide	on	picking	the	right	email	template.Yes,	even	in
something	as	seemingly	simple	as	an	acknowledgment	receipt,	there’s	room	for	slip-ups.	Let’s	dive	into	some	common	mistakes	and	how	to	steer	clear	of	them.Mistake	1:	Skipping	the	detailsWhether	you’re	part	of	a	big	business	firm	or	a	small	startup,	details	matter.	When	confirming	receipt,	it’s	crucial	to	mention	specifics	like	transaction	numbers,
payment	methods,	dates,	or	any	other	relevant	details.	This	not	only	shows	that	you’re	paying	attention	but	also	helps	avoid	any	confusion	down	the	line.Mistake	2:	Using	an	overly	formal	toneRemember,	confirming	receipt	is	not	just	about	maintaining	records—it’s	also	about	building	relationships.	So,	keep	your	tone	friendly	and	approachable.	While
professionalism	is	important,	there’s	no	need	to	sound	like	a	robot.	A	little	warmth	goes	a	long	way.Mistake	3:	Delaying	the	acknowledgment	receiptTime	is	of	the	essence	when	confirming	receipt.	The	sooner	you	send	your	acknowledgment,	the	sooner	the	sender	knows	their	message	or	item	has	been	received.	This	helps	build	trust	and	shows	that
you	respect	the	sender’s	time.Mistake	4:	Not	proofreading	your	emailTypos	and	grammatical	errors	can	make	even	the	most	well-crafted	emails	seem	unprofessional.	So,	before	you	hit	send,	take	a	moment	to	proofread	your	email.	Your	future	self	will	thank	you.At	the	end	of	the	day,	confirming	receipt	is	more	than	just	good	etiquette—it’s	also	a
powerful	tool	for	maintaining	open	and	transparent	professional	communication.	Whether	you’re	part	of	a	big	business	firm	or	a	small	startup,	a	timely	acknowledgment	can	make	all	the	difference	in	how	your	business	is	perceived.So,	why	not	make	it	a	part	of	your	daily	routine?	Start	sending	those	confirmation	emails	in	a	timely	manner,	and	watch
as	your	professional	relationships	thrive.	Because	sometimes,	it’s	the	small	things	that	make	the	biggest	impact.	How	to	Send	Gmail	with	a	Read	Receipt?	Are	you	tired	of	sending	emails	only	to	have	them	go	unread?	Have	you	ever	wondered	if	the	person	you	sent	an	email	to	actually	opened	it?	If	so,	you’re	not	alone.	In	this	article,	we’ll	explore	how
to	send	Gmail	with	a	read	receipt,	giving	you	the	power	to	track	whether	your	emails	have	been	opened	or	not.	What	is	a	Read	Receipt?	A	read	receipt	is	a	feature	that	allows	the	sender	to	track	whether	the	recipient	has	opened	an	email	or	not.	This	feature	is	often	used	in	professional	settings	to	ensure	that	important	communications	are	not
ignored.	When	you	send	an	email	with	a	read	receipt,	the	recipient’s	email	client	(e.g.,	Gmail,	Outlook,	or	Yahoo)	will	detect	when	the	email	is	opened	and	send	a	notification	back	to	you.	How	to	Send	Gmail	with	a	Read	Receipt?	Sending	a	Gmail	with	a	read	receipt	is	a	simple	process	that	can	be	done	in	a	few	steps.	Here’s	how:	Method	1:	Using	the
Insert	Menu	Open	Gmail	and	compose	a	new	email	as	you	normally	would.	In	the	Insert	menu,	select	Get	analytics.	In	the	Analytics	window,	toggle	the	Request	read	receipt	switch	to	On.	Send	your	email	as	usual.	Method	2:	Using	the	Compose	Window	Open	Gmail	and	compose	a	new	email	as	you	normally	would.	Click	on	the	three	vertical	dots	at	the
bottom	of	the	compose	window.	Select	Request	read	receipt.	Toggle	the	switch	to	On.	Send	your	email	as	usual.	How	to	View	Read	Receipts	in	Gmail	Once	you’ve	sent	an	email	with	a	read	receipt,	you	can	view	the	results	in	your	Inbox.	Here’s	how:	Open	Gmail	and	go	to	your	Inbox.	Click	on	the	b	reply	button	next	to	the	email	you	sent	with	a	read
receipt.	A	Open	confirmation	message	will	appear	at	the	top	of	the	email,	indicating	whether	the	recipient	opened	the	email	or	not.	Tips	and	Tricks	Read	receipts	only	work	for	email	clients	that	support	them,	such	as	Gmail,	Outlook,	and	Yahoo.	If	the	recipient	uses	a	different	email	client,	the	read	receipt	feature	may	not	work.	Read	receipts	are	not
always	100%	accurate,	as	the	recipient	may	open	the	email	but	not	trigger	the	read	receipt.	Sending	too	many	emails	with	read	receipts	can	be	spammy,	so	use	this	feature	sparingly	and	only	when	necessary.	Read	receipts	are	not	available	for	all	types	of	emails,	such	as	emails	sent	from	mobile	devices	or	emails	sent	to	groups.	Security	Concerns
Read	receipts	can	be	a	privacy	concern,	as	they	allow	the	sender	to	track	the	recipient’s	online	activities.	If	you’re	concerned	about	privacy,	you	may	want	to	consider	using	an	alternative	method,	such	as	a	BCC	(Blind	Carbon	Copy)	or	carbon	copy,	which	will	send	a	copy	of	the	email	to	the	recipient	without	revealing	their	email	address.	Conclusion
Sending	a	Gmail	with	a	read	receipt	is	a	simple	and	effective	way	to	track	whether	your	emails	have	been	opened	or	not.	By	following	the	steps	outlined	in	this	article,	you	can	request	a	read	receipt	and	stay	informed	about	the	effectiveness	of	your	email	campaigns.	Remember	to	use	this	feature	responsibly	and	consider	the	privacy	implications
before	using	it.	Happy	emailing!	Your	friends	have	asked	us	these	questions	-	Check	out	the	answers!	How	to	Send	an	Email	with	a	Read	Receipt	in	Outlook	Why	Send	an	Email	with	a	Read	Receipt?	In	today’s	fast-paced	digital	age,	sending	emails	has	become	an	essential	part	of	our	daily	communication.	With	the	rise	of	email	as	a	primary	means	of
communication,	it’s	essential	to	ensure	that	your	messages	are	delivered	and	acknowledged.	Sending	an	email	with	a	read	receipt	can	be	a	powerful	tool	in	this	regard,	giving	you	a	clear	indication	of	whether	the	recipient	has	read	your	email.	In	this	article,	we	will	explore	how	to	send	an	email	with	a	read	receipt	in	Outlook.	Enabling	Read	Receipt	in
Outlook	Before	we	dive	into	the	process	of	sending	an	email	with	a	read	receipt,	it’s	essential	to	ensure	that	you	have	read	receipts	enabled	in	your	Outlook	settings.	Here’s	how	to	do	it:	For	Microsoft	Office	365	Users:	Open	Outlook	and	go	to	File	>	Options	>	General.	Under	Send,	toggle	the	Request	a	read	receipt	button	to	the	"On"	position.	For
Outlook	2013	and	2016	Users:	Click	on	File	>	Options	>	Advanced.	Under	Threads,	toggle	the	Request	a	read	receipt	checkbox	to	the	"On"	position.	For	Outlook	2007	Users:	Go	to	Tools	>	Options	>	Preferences.	Under	Read	Receipts,	toggle	the	Request	read	receipt	before	sending	messages	checkbox	to	the	"On"	position.	Sending	an	Email	with	a
Read	Receipt	Once	read	receipts	are	enabled,	you	can	send	an	email	with	a	read	receipt	by	following	these	steps:	Compose	a	new	email:	Click	on	the	Compose	button	to	create	a	new	email.	Add	the	recipient:	Enter	the	recipient’s	email	address	in	the	To	field.	Request	a	read	receipt:	Click	on	the	Options	button	and	select	Request	Read	Receipt	from
the	drop-down	menu.	Send	the	email:	Click	Send	to	send	the	email.	What	Happens	After	Sending	the	Email	After	sending	an	email	with	a	read	receipt,	you	can	track	the	recipient’s	reading	activity:	Read	receipt	request:	The	recipient	will	receive	a	notification	requesting	that	they	confirm	whether	they	have	read	the	email.	Read	receipt	report:	Once
the	recipient	confirms	having	read	the	email,	a	read	receipt	report	will	be	sent	to	you,	indicating	the	time	and	date	they	read	the	email.	Tips	and	Variations	Specify	a	deadline:	You	can	set	a	deadline	for	the	recipient	to	respond	to	the	read	receipt	request.	To	do	this,	click	on	Options	and	select	Set	delivery	and	read	receipt	options.	In	the	Delivery	and
read	receipt	options	window,	enter	the	desired	deadline	in	the	Read	receipt	reminder	field.	Send	to	multiple	recipients:	You	can	send	an	email	with	a	read	receipt	to	multiple	recipients,	but	each	recipient	will	need	to	confirm	separately.	Troubleshooting	Issues	Recipient	refused	the	read	receipt	request:	If	a	recipient	refuses	a	read	receipt	request,	you
will	receive	an	email	stating	that	the	recipient	has	declined	the	request.	Recipient’s	email	client	doesn’t	support	read	receipts:	If	a	recipient	uses	an	email	client	that	doesn’t	support	read	receipts,	you	won’t	receive	a	read	receipt	report.	Conclusion	In	conclusion,	sending	an	email	with	a	read	receipt	in	Outlook	is	a	simple	process	that	can	help	you
track	the	reading	activity	of	your	emails.	By	following	the	steps	outlined	in	this	article,	you	can	ensure	that	your	emails	are	delivered	and	acknowledged,	giving	you	a	clear	indication	of	when	your	recipients	have	read	your	messages.	Remember	to	enable	read	receipts	in	your	Outlook	settings	and	specify	a	deadline	for	the	recipient	to	respond	to	the
read	receipt	request.	With	these	tips	and	variations	in	mind,	you’ll	be	well	on	your	way	to	maximizing	the	effectiveness	of	your	email	communications.	Your	friends	have	asked	us	these	questions	-	Check	out	the	answers!




